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SUMMARY:
The atmospheric concentrations of weakly bound molecular clusters can be computed from the thermochemical properties of low energy structures found through a multi-step configurational sampling methodology utilizing a genetic algorithm and semi-empirical and ab initio quantum chemistry.

ABSTRACT:
[bookmark: OLE_LINK1][bookmark: OLE_LINK2]The computational study of the formation and growth of atmospheric aerosols requires an accurate Gibbs free energy surface, which can be obtained from gas phase electronic structures and vibrational frequencies. These quantities are valid for those atmospheric clusters whose geometries correspond to a minimum on their potential energy surfaces. The Gibbs free energy of the minimum energy structure can be used to predict atmospheric concentrations of the cluster under a variety of conditions such as temperature and pressure. We present a computationally inexpensive procedure built on a genetic algorithm-based configurational sampling followed by a series of increasingly accurate screening calculations. The procedure starts by generating and evolving the geometries of a large set of configurations using semi-empirical models then refines the resulting unique structures at a series of high-level ab initio levels of theory. Finally, thermodynamic corrections are computed for the resulting set of minimum-energy structures and used to compute the Gibbs free energies of formation, equilibrium constants, and atmospheric concentrations. We present the application of this procedure to the study of hydrated glycine clusters under ambient conditions.

INTRODUCTION:
The most uncertain parameter in atmospheric studies of climate change is the exact extent to which cloud particles reflect incoming solar radiation. Aerosols, which are particulate matter suspended in a gas, form cloud particles called cloud condensation nuclei (CCN) that scatter incoming radiation, thus preventing its absorption and the subsequent heating of the atmosphere1. A detailed understanding of this net cooling effect requires an understanding of the growth of aerosols into CCNs, which in turn requires an understanding of the growth of small molecular clusters into aerosol particles. Recent work has suggested that aerosol formation is initiated by molecular clusters of 3 nm in diameter or less2; however, this size regime is difficult to access using experimental techniques3,4. Therefore, a computational modeling approach is desired in order to overcome this experimental limitation. 

Using our modeling approach described below, we can analyze the growth of any hydrated cluster. Because we are interested in the role of water in the formation of large biological molecules from smaller constituents in pre-biotic environments, we illustrate our approach with glycine. The challenges encountered and tools needed to address those research questions are very similar to those involved in the study of atmospheric aerosols and prenucleation clusters5-15. Here, we examine hydrated glycine clusters starting from an isolated glycine molecule followed by a series of stepwise additions of up to five water molecules. The final goal is to calculate the equilibrium concentrations of Gly(H2O)n=0-5 clusters in the atmosphere at room temperature at sea-level and a relative humidity (RH) of 100 %. 

A small number of these subnanometer molecular clusters grow into a metastable critical cluster (1-3 nm in diameter) either by adding other vapor molecules or coagulating on existing clusters. These critical clusters have a favorable growth profile leading to the formation of much larger (up to 50-100 nm) cloud condensation nuclei (CCN), which directly affect the precipitation efficiency of clouds as well their ability to reflect incident light. Therefore, having a good understanding of the thermodynamics of molecular clusters and their equilibrium distributions should lead to more accurate predictions of the impact of aerosols on the global climate.

A descriptive model of aerosol formation requires accurate thermodynamics of molecular cluster formation. The computation of accurate thermodynamics of molecular cluster formation requires the identification of the most stable configurations, which involves finding the global and local minima on the cluster’s potential energy surface (PES)16. This process is called configurational sampling and can be achieved through a variety of techniques, including those based on molecular dynamics (MD)17-20, Monte Carlo (MC)21,22, and genetic algorithms (GA)23-25. 

Different protocols have been developed over the years to obtain the structure and thermodynamics of atmospheric hydrates at a high level of theory. These protocols differed in the choice of (i) configurational sampling method, (ii) nature of low-level method used in the configurational sampling, and (iii) the hierarchy of higher level methods used to refine the results in the subsequent steps.

The configurational sampling methods included chemical intuition26, random sampling27,28, molecular dynamics (MD)29,30, basin hopping (BH)31, and genetic algorithm (GA)24,25,32. The most common low-level methods employed with these sampling methods are force fields or semi-empirical models such as PM6, PM7 and SCC-DFTB. These are often followed by DFT calculations with increasingly larger basis sets and more reliable functionals from the higher rungs of Jacob’s ladder33. In some cases, these are followed by higher level wavefunction methods such as MP2, CCSD(T), and the cost efficient DLPNO-CCSD(T)34,35.

Kildgaard et al.36 developed a systematic method where water molecules are added at points on the Fibonacci spheres37 around smaller hydrated or unhydrated clusters to generate candidates for larger clusters. Unphysical and redundant candidates are removed based on close contact thresholds and root-mean-square distance between different conformers. Subsequent optimizations using the PM6 semi-empirical method and a hierarchy of DFT and wavefunction methods are used to get a set of low energy conformers at a high level of theory.
The artificial bee colony (ABC) algorithm38 is a new configurational sampling approach that has recently been implemented by Zhang et al. to study molecular clusters in a program called ABCluster39. Kubecka et al.40 used ABCluster for configurational sampling followed by low-level reoptimizations using the tight-binding GFN-xTB semi-empirical method41. They further refined the structures and energies using DFT methods followed by final energies using DLPNO-CCSD(T).

Regardless of the method, configurational sampling starts with a randomly- or nonrandomly-generated distribution of points on the PES. Each point corresponds to a specific geometry of the molecular cluster in question and is generated by the sampling method. Then the closest local minimum is found for each point by following the “downhill” direction on the PES. The set of minima thus found correspond to those geometries of the molecular cluster that are stable, at least for some time. Here, the shape of the PES and the evaluation of the energy at each point on the surface will be sensitive to the physical description of the system where a more accurate physical description results in a more computationally expensive energy calculation. We will specifically use the GA method implemented in the OGOLEM25 program, which has been successfully applied to a variety of global optimization and configurational sampling problems42-45, to generate the initial set of sampling points. The PES will be described by the PM7 model46 implemented in the MOPAC2016 program47. This combination is employed because it generates a larger variety of points compared to the MD and MC methods and finds the local minima faster than more-detailed descriptions of the PES.

The set of GA-optimized local minima are taken as the starting geometries for a series of screening steps, which lead to a set of low lying minimum energy. This part of the protocol begins by optimizing the set of unique GA-optimized structures using density-functional theory (DFT) with a small basis set. This set of optimizations will generally give a smaller set of unique local minimum structures which are modeled in more detail compared to the GA-optimized semi-empirical structures. Then another round of DFT optimizations are performed on this smaller set of structures using a larger basis set. Again, this step will generally give a smaller set of unique structures which are modeled in more detail compared to the small basis DFT step. The final set of unique structures are then optimized to a tighter convergence and the harmonic vibrational frequencies are calculated. After this step we have everything we need to compute the equilibrium concentrations of the clusters in the atmosphere. The overall approach is summarized diagrammatically in Figure 1. We will use the PW9148 generalized-gradient approximation (GGA) exchange-correlation functional in the Gaussian0949 implementation of DFT along with two variations of the Pople50 basis set (6-31+G* for the small basis step and 6-311++G** for the large basis step). This particular combination of exchange-correlation functional and basis set was chosen due to its previous success in computing accurate Gibbs free energies of formation for atmospheric clusters51,52.

This protocol assumes that the user has access to a high-performance computing cluster with the PBS portable batch system53, MOPAC2016 (http://openmopac.net/MOPAC2016.html)47, OGOLEM (https://www.ogolem.org)25, Gaussian 09 (https://gaussian.com)49, and OpenBabel54 (http://openbabel.org/wiki/Main_Page) software installed following their specific installation instructions. Each step in this protocol also uses a set of in-house shell and Python 2.7 scripts which must be saved to a directory that is included in the user’s $PATH environmental variable. All necessary environmental modules and execution permissions to run all of the above programs must also be loaded into the user’s session.
 
PROTOCOL:

1. [bookmark: _Hlk29199712]Finding the minimum energy structure of isolated glycine and water

NOTE: The goal here is two-fold: (i) to obtain minimum energy structures of isolated water and glycine molecules for use in the genetic algorithm configurational sampling, (ii) and to compute the thermodynamic corrections to the gas phase energies of these molecules for use in the calculation of atmospheric concentrations.

1.1. Open a new session in Avogadro. Click Build > Insert > Peptide > Gly > Insert Peptide to generate a glycine monomer in the visualization window. Click Extensions > Gaussian and edit the first line in the text box to read ‘# pw91pw91/6-311++G** int(Acc2E=12,UltraFine) scf(conver=12) opt(tight,maxcyc=300) freq’. 

1.1.1. Click Generate and save the command file as glycine.com. Please note that if the molecule has significant conformational flexibility, as glycine does55, it is critical to perform conformational analysis to identify the global minimum structure and other low-lying conformers. OpenBabel54 provides robust conformational search tools utilizing different algorithms and quick force fields. While conformers are allowed to relax and interconvert during GA and subsequent calculations, it is sometimes necessary to run multiple GA calculations, each starting with a different conformer. 

1.2. Open a new session in Avogadro. Click the first button in the toolbar and choose Element: Oxygen in the Drawing Settings box while making sure Adjust Hydrogens is checked in. Click Extensions > Gaussian and edit the first line in the text box to read ‘# pw91pw91/6-311++G** int(Acc2E=12,UltraFine) scf(conver=12) opt(tight,maxcyc=300) freq’. Click Generate and save the command file as water.com.

1.3. Transfer the two .com files to the computing cluster and call Gaussian 09 in a submit script to start the calculation. Once the calculations finish, generate .xyz files of the minimum energy structures by calling OpenBabel. For glycine, the command-line command is ‘obabel -ig09 glycine.log -oxyz > glycine.xyz’. These two .xyz files will be used by the GA configurational sampling in the next step.
 
2. Genetic-algorithm-based configurational sampling of Gly(H2O)n=1-5 clusters

NOTE: The goal here is to obtain a set of low-energy structures for Gly(H2O)n=1-5 at the inexpensive semi-empirical level of theory, using the PM746 model implemented in MOPAC47. It is imperative that the working directory has the exact organization and structure as shown in Figure 2. This is to ensure that the custom shell and Python scripts work without failures.

2.1. Create a directory called gly-h2o-n where n is the number of water molecules. Create a subdirectory called GA under the gly-h2o-n directory to run generic algorithm calculations. Copy the OGOLEM input files (Eg. pm7.ogo), monomers Cartesian coordinates (Eg. glycine.xyz, water.xyz) and PBS batch submission script (Eg. run.pbs) into the GA directory. When submitting the calculation, OGOLEM will create a new directory named as the prefix of the OGOLEM input file (Eg. pm7) in the GA directory and store newly generated coordinates there. 

2.2. Once the calculation is complete, change directory to gly-h2o-n/GA/pm7 and compute the rotational constants of the GA-optimized clusters with the command ‘getRotConsts-GA.csh N 0 99’ where N is the number of atoms in the molecular cluster. This will generate a file called rotConstsData_C which contains a sorted list of all the GA-optimized cluster configurations, their energies, and their rotational constants.

2.3. Find and save the unique GA-optimized clusters with the command ‘similarityAnalysis.py pm7 rotConstsData_C’ where pm7 will be used as a file-naming label. This will generate a file called uniqueStructures-pm7.data which contains a sorted list of the unique GA-optimized configurations. This is a list of unique local minimum structures for the Gly(H2O)n cluster optimized at the PM7 level of theory, and these structures are now ready to be refined using DFT.

2.4. Go up to the gly-h2o-n/GA directory and combine the results from multiple comparable GA runs using the combineGA.csh script. The syntax is ‘combineGA.csh <label> <list of directories with GA runs>’. In this particular case, the command ‘combineGA.csh pm7 pm7’ will generate a new unique structures list named ‘uniqueStructures-pm7.data’ in the gly-h2o-n/GA directory.

3. Configurational sampling at the small-basis ab initio level of theory

NOTE: The goal here is to refine the configurational sampling of the Gly(H2O)n=1-5 clusters using a better quantum-mechanical description to obtain a smaller but more accurate set of Gly(H2O)n=1-5 cluster structures. The starting structures for this step are the outputs of Step 2.

3.1. Create a subdirectory called QM under the gly-h2o-n directory. Under the QM directory, create another subdirectory named pw91-sb. Copy the unique structures list (uniqueStructures-pm7.data) from the gly-h2o-n/GA directory to the QM/pw91-sb directory and change directory to that gly-h2o-n/QM/pw91-sb.

3.1.1. Run the small-basis DFT configurational sampling script with the command ‘run-pw91-sb.csh uniqueStructures-pm7.data sb QUEUE 10’ where QUEUE is the preferred queue on the computing cluster. This script will automatically generate the inputs for Gaussian 09 and submit all the calculations. Enter ‘test’ for the ‘QUEUE’ to do a dry run.

3.2. Once the submitted calculations are complete, extract the energies and compute the rotational constants of the small-basis-optimized clusters with the command ‘getRotConsts-dft-sb.csh pw91 N’ where N is the number of atoms in the cluster. That will create a file named rotConstsData_C. Now identify the unique structures with the command ‘similarityAnalysis.py sb rotConstsData_C’. There will now be a list of unique configurations optimized at the PW91/6-31+G* level of theory saved in the file uniqueStructures-sb.data.

3.3. Go up to the gly-h2o-n/QM directory and combine the results from multiple comparable QM runs using the combineQM.csh script. The syntax is ‘combineQM.csh <label> <list of directories with QM calculations>’. In this particular case, the command ‘combineQM.csh sb pw91-sb’ will generate a new unique structures list named ‘uniqueStructures-sb.data’ in the gly-h2o-n/QM directory.

4. Configurational sampling at the large-basis ab initio level of theory

NOTE: The goal here is to further refine our configurational sampling of the Gly(H2O)n=1-5 clusters using a better quantum-mechanical description. The starting structures for this step are the outputs of Step 3.

4.1. Create a subdirectory called pw91-lb under the QM directory. Copy the unique structures list (uniqueStructures-sb.data) from the QM/pw91-sb directory to the QM/pw91-lb directory and change directory to QM/pw91-lb. Run the large-basis DFT configurational sampling script with the command ‘run-pw91-lb.csh uniqueStructures-sb.data lb QUEUE 10’ where QUEUE is the preferred queue on the computing cluster. This script will automatically generate the inputs for Gaussian 09 and submit all the calculations. Enter ‘test’ for the ‘QUEUE’ to do a dry run testing.

4.2. Once the submitted calculations are complete, compute the rotational constants of the large-basis-optimized clusters with the command ‘getRotConsts-dft-lb.csh pw91 N’ where N is the number of atoms in the cluster. Now identify the unique structures with the command ‘similarityAnalysis.py lb rotConstsData_C’. We now have a list of unique configurations optimized at the PW91/6-311++G** level of theory saved in the file uniqueStructures-lb.data.

5. Vibrational analysis

NOTE: The goal here is to obtain the vibrational structure and energies of the Gly(H2O)n=1-5 clusters in order to compute the desired thermochemical corrections.

5.1. Copy the unique structures list (uniqueStructures-lb.data) from the QM/pw91-lb directory to the QM/pw91-lb/ultrafine directory and change directory to QM/pw91-lb/ultrafine. Run the ultrafine large-basis DFT script with the command ‘run-pw91-lb-ultrafine.csh uniqueStructures-lb.data uf QUEUE 10’ where QUEUE is the preferred queue on the computing cluster. This script will automatically generate the inputs for Gaussian 09 and submit all the calculations. Enter ‘test’ for the ‘QUEUE’ to do a dry run testing.

5.2. Once the submitted calculations are complete, compute the rotational constants of the large-basis-optimized clusters with the command ‘getRotConsts-dft-lb-ultrafine.csh pw91 N’ where N is the number of atoms in the cluster. Now identify the unique structures with the command ‘similarityAnalysis.py uf rotConstsData_C’. We now have a list of unique configurations optimized at the PW91/6-311++G** level of theory saved in the file uniqueStructures-uf.data.

5.3. Compute the thermodynamic corrections with the command ‘run-thermo-pw91.csh uniqueStructures-uf.data’ and copy/paste the command-line output to a spreadsheet with a name like gly-h2o-n.xls.

6. Computing atmospheric concentrations of Gly(H2O)n=0-5 clusters at room temperature at sea-level

NOTE: This is accomplished by setting up a system of chemical equilibria for the sequential hydration of glycine as shown below.



6.1. Compute the equilibrium constants  using , where  is the level of hydration,  is the Gibbs free energy change of the nth hydration reaction,  is Boltzmann’s constant, and  is temperature.



6.2. Set up the equation for the conservation of mass, using the assumption that the sum of the equilibrium concentrations of the hydrated and un-hydrated glycine clusters equals the initial concentration of isolated glycine . Rewrite this system of six simultaneous equations, using some algebraic rearrangement of the equilibrium constant expressions, as


6.3. Solve the system of equations shown above to obtain the equilibrium concentrations of Gly(H2O)n=0-5 using an experimental value56-58 for the concentration of glycine in the atmosphere, , and the concentration of water in the atmosphere at 100% relative humidity and a temperature of 298.15 K59, .

REPRESENTATIVE RESULTS:
The first set of results from this protocol should be a set of low-energy structures of Gly(H2O)n=1-5 found through the configurational sampling procedure. These structures have been optimized at the PW91/6-311++G** level of theory and are assumed to be accurate for the purpose of this paper. There is no evidence to suggest that PW91/6-311++G** consistently underestimates or overestimates the binding energy of these clusters. Its ability to predict binding energies relative to MP2/CBS32 and [DLPNO-]CCSD(T)/CBS60,61 estimates and experiment52 shows a lot of fluctuations. The same is true of most other density functionals.

The disk and memory usage by the GA code (OGOLEM) and semi-empirical codes (MOPAC) are very small by modern computer resource standards. The overall memory and disk usage for OGOLEM/MOPAC depends on how many threads one wants to use, and even then the resource usage will be small compared to the capabilities of most HPC systems. The resource needs of the QM methods depend on the size of the clusters and the level of theory used. The advantage of using this protocol is that one can vary the level of theory to be able to calculate the final set of low energy structures, keeping in mind that usually faster calculations lead to more uncertainty in accuracy of the results.

Generally, each value of n = 1 – 5 should yield a handful of low-energy structures within around 5 kcal mol-1 of the lowest-energy structure. Here, we focus on the first structure produced by the run-thermo-pw91.csh script for brevity. Figure 3 shows the lowest electronic energy isomers of Gly(H2O)n=0-5 clusters. One can see that the hydrogen bond network grows in complexity as the number of water molecules increases, and even goes from a mostly planar network to a three-dimensional cage-like structure at n = 5. The rest of this text uses the energies and thermodynamic quantities corresponding to these five specific clusters.

Table 1 contains the thermodynamic quantities necessary to carry out the protocol. Table 2 shows an example of the output of the run-thermo-pw91.csh script where the electronic energies, vibrational zero-point corrections, and the thermodynamic corrections at three different temperatures are printed. For each cluster (row), E[PW91/6-311++G**] corresponds to the gas phase electronic energies at the PW91/6-311++G** level of theory calculated on ultrafine integration grids in units of Hartree, as well as the zero-point vibrational energy (ZPVE) in units of kcal mol-1. At each temperature, 216.65 K, 273.15 K, and 298.15 K, the thermodynamic corrections are listed, ∆H the enthalpy of formation, S the entropy of formation, and ∆G the Gibbs free energy of formation in units of kcal mol-1. Table 3 shows an example computation of the total Gibbs free energy change of hydration, as well as for sequential hydration. An example computation of the total Gibbs free energy change of hydration for the reaction



starts with the computation of the electronic energy  as



where  is taken from Table 2 column C, and  and  are taken from Table 1 column B. Next we calculate the total gas phase energy change  by including the change in the zero-point vibrational energy of the reaction as



to obtain column D. Here,  is taken from Table 3 column C,  from Table 2 column D, and  and  from Table 1 column C. For the sake of brevity, we will move on to room temperature clusters, so we skip over the 216.65 K and 273.15 K data. At room temperature, we then calculate the enthalpy change of the reaction  by correcting the gas phase energy change as



where  is taken from Table 3 column D,  is taken from Table 2 column K, and  and  are taken from Table 1 column J. Finally, we calculate the Gibbs free energy change of the reaction  as



where  is taken from Table 3 column I,  is taken from Table 2 column L, and  and  are taken from Table 1 column K. 

We now have the necessary quantities to compute the atmospheric concentrations of hydrated glycine as shown in Step 6. The results should resemble the data shown in Table 4, but small numerical differences are to be expected. Table 4 shows the formulation of the system of six equations in Step 6.2 into one matrix equation and its subsequent solution. We start by acknowledging the fact that the system of equations can be written as



where  is the equilibrium constant for the nth sequential hydration of glycine,  is the concentration of water in the atmosphere,  is the initial concentration of isolated glycine in the atmosphere, and  is the equilibrium concentration of Gly(H2O)n. If we rewrite the above equation as , we get  where  is the inverse of matrix . This inverse can be easily computed using built-in spreadsheey functions as shown in Table 4 to obtain the final results.

As presented, this protocol gives a qualitative understanding of the hydrated glycine populations in the atmosphere. Assuming a non-equilibrium concentration of isolated glycine of 2.9 million molecules per cubic centimeter, we see that the singly-hydrated glycine is the most abundant cluster in the atmosphere, followed by the triply- and quadruply-hydrated clusters. The larger clusters are predicted to be found in negligible amounts. Upon inspection of Figure 3, the abundance of the n = 1 – 4 clusters can be related to the stability and strain in the hydrogen bond network of the clusters. These clusters have the water molecules hydrogen bonded to the carboxylic acid moiety of glycine in a geometry closely resembling those of various hydrogen-bonded ring structures, making them especially stable. 

FIGURE AND TABLE LEGENDS:
Figure 1. Schematic description of the current procedure. A large pool of guess structures generated by the genetic algorithm (GA) is refined by a series of PW91 geometry optimizations until a set of converged structures are obtained. The vibrational frequencies of these structures are computed and used to compute the Gibbs free energy of formation, which is in turn used to compute the equilibrium concentrations of the clusters under ambient conditions.

Figure 2. Representative directory structure for each cluster. The in-house scripts included in this protocol require the directory structure shown above, where n is the number of water molecules. For each n in gly-h2o-n, there are the following subdirectories: GA for genetic algorithm with a GA/pm7 directory, QM for quantum mechanics with QM/pw91-sb for PW91/6-31+G*, QM/pw91-lb for PW91/6-311++G**, and QM/pw91-lb/ultrafine for optimizations and final vibrational calculations on ultrafine integration grids.

Figure 3. Representative low energy structures of Gly(H2O)n=0-5. These clusters were the electronic energy global minima optimized at the PW91/6-311++G** level of theory.

Table 1. Monomer energies. Electronic energies are in units of Hartree while all other quantities are in units of kcal mol-1. Water and glycine were optimized at the PW91/6-311++G** level of theory and vibrational frequencies were computed. The thermodynamic corrections for a pressure of 1 atm and temperature of 298.15 K were computed using the thermo.pl script.

Table 2. Cluster energies. The energies of the lowest-energy Gly(H2O)n=1-5 structures found using our procedure outlined in Figure 1. Electronic energies are in units of Hartree while all other quantities are in units of kcal mol-1.

Table 3. Hydration energies. The total energy of hydration and energy of sequential hydration for Gly(H2O)n=1-5 in units of kcal mol-1. Here, E[PW91/6-311++G**] is the change in the electronic energy, ∆E(0) is the zero-point vibrational energy (ZPVE) corrected change in energy, ∆H(T) is the enthalpy change at temperature T, and ∆G(T) is the Gibbs free energy change of hydration of each Gly(H2O)n=1-5 cluster.

Table 4. Atmospheric concentrations. Table containing the computation of the equilibrium concentrations of atmospheric Gly(H2O)n=1-5 clusters. Here, kB is Boltzmann’s constant, R is the ideal gas constant, h is the Planck constant, kCtoJ is a conversion factor from kcal mol-1 to J mol-1, amutoKg is a conversion factor from atomic mass units to kilograms, NtoAtm is a conversion factor from number of molecules per cubic centimeter to partial pressure in atmospheres, and Na is Avogadro’s number. We used the experimental values56-58 of  and  at 100% relative humidity of and 59.

DISCUSSION:
The accuracy of the data generated by this protocol depends mainly on three things: (i) the variety of configurations sampled by Step 2, (ii) the accuracy of the electronic structure of the system, (iii) and the accuracy of the thermodynamic corrections. Each of these factors can be addressed by modifying the method by editing the included scripts. The first factor is easily overcome with the use of a larger initial pool of randomly generated structures, more numerous iterations of the GA, and a looser definition of the criteria involved in the GA. In addition, one may use a different semi-empirical method such as the self-consistent charge density-functional tight-binding (SCC-DFTB)62 model and the effective fragment potential (EFP)63 model in order to explore the effects of different physical descriptions. The main limitation here is the inability of the method to form or break covalent bonds, meaning that the monomers are frozen. The GA procedure only finds the most stable relative positions of these frozen monomers according to the semi-empirical description.

The accuracy of the electronic structure of the system can be improved in a variety of ways, each with its computational cost. One may choose a better density functional, such as M06-2X64 and wB97X-V65, or quantum chemical method such as the Møller-Plesset66-68 (MPn) perturbation theories and coupled-cluster69 (CC) methods in order to improve the physical description of the system. In the hierarchy of functionals, the performance generally improves upon going from generalized-gradient approximation (GGA) functionals like PW91 to range-separated hybrid functionals like wB97X-D and meta-GGA hybrid functionals like M06-2X.
The disadvantage of DFT methods is that a systematic convergence towards an accurate value is not possible; however, DFT methods are computationally inexpensive and there is a wide variety of functionals for a wide variety of applications. 

Energies calculated using wavefunction methods like MP2 and CCSD(T) in conjunction with correlation consistent basis sets of increasing cardinal number ([aug-]cc-pV[D,T,Q,...]Z) converge towards their complete basis set limit systematically, but the computational cost of each calculation becomes prohibitive as the system size grows. Further refinement of the electronic structure can be accomplished by using explicitly correlated basis sets70 and by extrapolating to the complete basis set (CBS)71 limit. Our recent work suggests that a density-fitted explicitly correlated second-order Møller-Plesset (DF-MP2-F12) perturbative approach yields energies approaching that of MP2/CBS computations32. Modification of the current protocol to use different electronic structure methods involves two steps: (i) prepare a template input file following the syntax given by the software, (ii) and edit the run-pw91-sb.csh, run-pw91-lb.csh, and run-pw91-lb-ultrafine.csh scripts to generate the correct input file syntax as well as the correct submit script for the software.

Lastly, the accuracy of the thermodynamic corrections depends on the electronic structure method as well as the description of the PES around the global minimum. An accurate description of the PES requires the computation of third- and higher-order derivatives of the PES with respect to displacements in the nuclear degrees of freedom, such as the quartic force field72,73 (QFF), which is an exceptionally costly task. The current protocol uses the harmonic oscillator approximation to the vibrational frequencies, resulting in the need to compute only up to second derivatives of the PES. This approach becomes problematic in systems with high anharmonicity, such as very floppy molecules and symmetric double-well potentials due to the large difference in the true PES and the harmonic PES. Furthermore, the cost of having a high-quality PES from a computationally demanding electronic structure method only compounds the problem of cost for vibrational frequency calculations. One approach to overcome this is to use the electronic energies from a high-quality electronic structure calculation along with vibrational frequencies computed on a lower quality PES, resulting in a balance between cost and accuracy. The current protocol can be modified to use different PES descriptions as described in the previous paragraph; however, one may also edit the vibrational frequency keywords in the scripts and templates to compute anharmonic vibrational frequencies.

Two crucial issues for any configurational sampling protocol are the initial method for sampling the potential energy surface and the criteria used to identify each cluster. We have made extensive use of a variety of methods in our previous work. For the first issue, the initial method for sampling the potential energy surface, we have made the choice of using GA with semi-empirical methods based on these factors. Configurational sampling using chemical intuition26, random sampling, and molecular dynamics (MD)29,30, fail to find putative global minima regularly for clusters larger than 10 monomers, as we observed in our studies of water clusters18. We have successfully used basin hopping (BH) to study the complex PES of (H2O)1174, but it required the manual inclusion of some potential low energy isomers the BH algorithm did not find. A comparison of the performance of BH and GA in finding the global minimum of water clusters, (H2O)n=10-20 demonstrated that GA consistently found the global minimum faster than BH75. GA as implemented in OGOLEM and CLUSTER is very versatile because it can be applied to any molecular cluster and it can interface with a vast number of packages with classical force field, semi-empirical, density functional, and ab initio capabilities. The choice of PM7 is driven by its speed and reasonable accuracy. Virtually any other semi-empirical method would have significantly higher computational cost. 

As for the second issue, we have explored using different criteria to identify unique structures ranging from electronic energies, dipole moments, overlap RMSDs and rotational constants. Using dipole moments proved difficult because both the dipole moment components were dependent on the molecule’s orientation and the total dipole moment was very sensitive to geometry differences in such a way that it was difficult to set thresholds determining is structures are the same or unique. A combination of electronic energies and rotational constants proved to be most useful.

The current criteria for deeming two structures unique is based on an energy difference threshold of 0.10 kcal mol-1 and rotational constant difference of 1%. Therefore, two structures are considered different if their energies differ by more than 0.10 kcal mol-1 (~0.00015 a.u.) AND any of their three rotational constants (A, B, C) differ by more than 1%. Substantial internal benchmarks over the years found these thresholds to be reasonable choices. Our configurational sampling approach and screening methodology has been applied to very weakly bound clusters such as polyaromatic hydrocarbons complexed with water76,77 as well as strongly bound ternary sulfate hydrates containing ammonia and amines32. For clusters where there are different protonation states to be considered, the best approach is to run various GA calculations, each starting with monomers in different protonation states. This ensures that structures with different protonation states are carefully considered. However, the low-level DFT calculations often allow protonation states to change during the course of the geometry optimization, thereby yielding the most stable protonation state regardless of the starting geometry.

Our GA configurational sampling methods should work well even for floppy molecules as long as the GA codes are interfaced with general, non-parameterized methods that allow the monomers to adopt different configurations during the course of the GA run. For example, interfacing GA with PM7 would allow monomers’ structures to change, but if their bonds break as would happen when protonation states change, the structures may get discarded as unacceptable candidates.

We have considered different ways of correcting the shortcomings of the harmonic approximation, especially those arising from low vibrational frequencies. Incorporating the quasi-harmonic approximation into the current methodology is not difficult. However, there are still questions about the quasi-harmonic method, especially when it comes to the cutoff frequency below which it will be applied. Also, there are no rigorous benchmarking works examining the reliability of the quasi-RRHO approximation even though conventional wisdom suggests it should be an improvement over RRHO approximation.

The protocol thus presented may be generalized to any system of noncovalently-bound gas phase molecular clusters. It may also be generalized to use any semi-empirical method, electronic structure method and software, and vibrational analysis method and software by editing the scripts and templates. This assumes that the user is comfortable with the Unix command-line interface, Python scripting, and high-performance computing. The unfamiliar syntax and look of the Unix operating system and lack of scripting experience is the largest pitfall in this protocol and is where new students struggle the most. This protocol has been used successfully in a variety of implementations for years in our group, mostly focusing on the effects of sulfuric acid and ammonia on aerosol formation. Further improvements to this protocol will involve a more robust interface to more electronic structure software, alternative implementations of the genetic algorithm, and possibly the use of newer methods for faster computations of electronic and vibrational energies. Our current applications of this protocol are exploring the importance of amino acids in the early stages of aerosol formation in the current atmosphere and in the formation of larger biological molecules in prebiotic environments.
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